Hox, Moerbeek, & Schoot, chapter 2: popularity data [ HLM7 MANUAL ]

Introduction

This document shows how you can replicate the popularity data multilevel models from Multilevel analysis: Techniques and
applications (Hox, J. J., Moerbeek, M., & van de Schoot, R, 2018), Chapter 2. In this manual the software package HLM7 for
Windows was used. Results should be very similar to results obtained with other software packages, however due to conver-
gence and rounding issues, you might notice minor differences. This tutorial is based on earlier versions of similar manuals

and made by Laurent Smeets.

STEP 1: Downloading the data.

To download the popularity data go to https://multilevel-analysis.sites.uu.nl/datasets/ and follow the links to https://
github.com/MultiLevelAnalysis/Datasets-third-edition-Multilevel-book/blob/master/chapter%202/popularity/SPSS/

popular2.sav. We will use the .sav file in HLM, which can be found in the SPSS folder.

STEP 2: Loading the data.

1) To load the SPSS datafile go to File > Make new MDM file > Stat package input. In the new window that appears, select

HLM2 and press OK.

HLM for Windows

File | Basic Settings  Other Settings  Run Analysis  Help
Create a new model using an existing MDM file
Edit/Run eld command(.him/.mlm) file

Manually edit command(.hlm/.mlm) file

Save

Save As

Save model as .emf

Save mixed model as .emf
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Graph Equations

Graph Data

Preferences

Exit
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Both our level 1 and level 2 variables are in one and the same file (they can also be in two separate files as long as there is a

common identifying variable for the level 2 units). Therefore, in the new window that appears, select the popular2.sav data-

file for both levels (In this example level 1 and 2 by pressing Browse). Now simply look for the file and select it.
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File Name:

MDM File Name (use .mdm suffix)
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Next, we specify the ‘grouping’ variable (or identification variable), and which variables belong to which level. We start with

level one. Press Choose Variables to open the variables window. The ‘grouping’ variable (ID), in a two level analysis is the

identification variable at the second level (in a three level model there are two ID variables: one on the second level and one

on the third level). There can only be one grouping variable per level and the first level (in this example the pupil level) does

not need an ID variable. The ID variable is the only variable that we need to select in both level 1 and level 2. Since our sec-

ond level is the class level, the CLASS variable is our ID variable. All the other variables are selected only once together with

the level at which they were measured. In the window that appears we select the grouping variable and the level 1 varia-

bles. The grouping variable is CLASS. Therefore we select the ID checkbox for this variable. The level 1 variables are EXTRAV,

SEX and POPULAR. Select the in MDM checkbox for these variables. When you are done, press OK.

The dataset also includes Z-transformed variables, but these will be ignored in this example.
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In a similar way, we select the variables for Level 2. Press the lower Choose Variables button to specify level 2 variables.
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Once all variables have Make MDM - HLM2

been specified, it is time MDM template file 1 MDM File Name (use .mdm suffix)

to save the file. First File Name: 2 | popularity.mdm]

specify a filename in the Open mdmtfile| | Save mdmtfile|| Edit mdmtﬁle| Input File Type [SPSSfWindows j
upper right box, and

then press Save mdmt Structure of Data - this affects the notation only!

file. HLM will create & cross sectional (persons within groups) " measures within groups

multiple files (often with
the same name) while

¢ longitudinal (occasions within persons)

doing your analysis, it is -
Level-1 Specification

thus advised to create a
new folder for each Browse | Level-1 File Name: C:\Users\laure\Desktop\popular2.sav Choose Variables |

project you are working ~Missing Data? ’ Delete missing level-1 data when:

on, to prevent cluttering & No (" Yes " making mdm " running analyses

and confusion.

Level-2 Specification
After the file has been :

saved successfully, you Browse | Level-2File Name: C:Userslaure\Desktop\popular2.sav Choose Variables |
can generate the actual

i

multilevel file. First Spatial Dependence Specification
press Make MDM. This [~ Include spatial dependence matrix
will show a terminal . | Spatial Dep. File Name: > Variable

window for a few sec- 3 4 5

onds. Then Press Check

Stats. This will open a Done Il
text file with some de-
scriptive statistics from

your variables. Verify
that these are correct,
and then press Done.

J HLM2MDM - Kladblok — [m] X WHLM: him2 MDM File: popularity.mdm - [m] X
Bestand Bewerken Opmask Beeld Help File Basic Settings Other Settings Run Analysis Help
Outcome
~| 55 Level <<
LEVEL-1 DESCRIPTIVE STATISTICS Tevers
INTRCPT1
VARIABLE NAME N MEAN sD MINIMUM MAXTMUM EXTRAV
EXTRAV 2000 5.21 1.26 1.00 10.00 SEX
SEX 2000 0.51 8.50 0.00 1.00 POPULAR

POPULAR 2000 5.88 1.38 0.60 9.50

LEVEL-2 DESCRIPTIVE STATISTICS

VARIABLE NAME N MEAN SD MINIMUM MAXIMUM
TEXP 1lee 14.30 6.61 2.00 25.00

MDM template: C:\Users\laure\Desktop\popularity\popularity.mdmt
MDM file name: popularity.mdm

Date: Apr 15, 2018

Time: 11:42:09

Mixed|
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STEP 3: Model properties and options

Now that we have successfully loaded the data into the program, we can start building multilevel models. The first thing that
has to be done is specifying the outcome variable. Press POPULAR and select Outcome Variable.

E‘ WHLM: him2 MDM File: popularity.mdm . a X WHLM: him2 MDM File: popularity.mdm - ] X
File Basic Settings Other Settings Run Analysis Help File Basic Settings Other Settings Run Analysis Help
Outcome Outcome LEVEL 1 MODEL (bold: group-mean centering; bold italic: grand-mean centering) »
>> Level-1 << >> Level-1 << P _
Level-2 Level-2 OPULAR = g, +r
INTRCPT1 Stephen Raudenbush INTRCPT1 LEVEL 2 MODEL (bold taiic: grand-mean centering)
EXTRAV Anthony Bryk EXTRAV £ =1 tu
s Richard Congd SEx e
POPLIL AR ICHardECongcon POPULAR
Outcome variable
add variable uncentered
add variable group centered
add variable grand centered
Delete variable from model
Mixed Mixed| v

We can now start building models. However, there are a few options we want to change first. In the HLM7 menu bar, go to
Other Settings > Estimation Settings. In the window that pops up, select Full Maximum Likelihood, and then press OK.

WHLM: him2 MDM File: popularity. mdm

0 |

File Basic Settings = Other Settings  Run Analysis  Help
OQutcome . : L ~Type of Likelihood
S L LA T bold ftalic: grand-me |~ Restricted maximum likelihood [ Rl meximum Ticelincod |
| 2% LEWER <K | f Estimation Settings
Level-2 e ~Adaptive Gaussian Quadrature Iteration Control

INTRCPTH L . ring) I Do adaptive Caussian iterations  Maximum number of iterations I

EXTRAV Output Settings

SEX |: MNumber of quadrature points I

POPULAR Exploratory Analysis (level 2) " First derivative " Second derivative

Exploratory Analysis (level 3)

Estimation Settings - HLM2

—LaPlace Iteration Control

I Do EM Laplace iterations Maximum number of iterations

—

™ Run as spatial dependence model [~ Diagonalize Tau

Constraint of fixed eﬁectsl Heterogeneous sigma®2 | Plausible valuesl Multiple impulalionl

Level-1 Deletion Variablesl Weighting |

Fix sigma*2 to specific value Icomputed

(Set to "computed” if you want sigma*2
random or if over-dispersion is desired)

Latent Variable Regression |

Mixedl v
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Second, for the final model we will also need
the variance-covariance matrix. To ask for
this go to Other Settings > Output Settings.
In the window that pops up, select Print
variance-covariance matrix, and then press
OK.

STEP 4: Building Models

Once the data is loaded, and all options have
been set, we can start building multilevel
models. The first model we want to build is
the intercept-only model, with error terms on
both levels. Therefore we do not have to add
any predictor variables yet. Your window
should look like this:

To calculate the model parameters, press
Run Analysis from the menu bar, and in the
window that pops up, press Run the Model
Shown. You should see the terminal window
for a few seconds, which fits the model. After
the model has been fitted, a html file with
the model output should be saved on the
location that you specified during STEP 2.

WHLM: him2 MDM File: popularity.mdm - O x
File Basic Settings = Other Settings  Run Analysis  Help
Outcome L lteration Settings bold italic: grand-mean centering) ~
>> Level1 << I Estimation Settings
Bevel 2 Hypothesis Testing
INTRCPT1 L . ring)
EXTRAV Output Settings
SEX .
FOPULAR Exploratory Analysis (level 2)
Exploratory Analysis (level 3)
Cuput Settings - HLM2
# of OLS estimates shown |10
||7 Print variance-covariance matrices I
[+ Reduced output
Mixed| v
WHLM: him2 MDM File: popularity.mdm - a X
File Basic Settings Other Settings Run Analysis Help
Outcome LEVEL 1 MODEL (bold: group-mean centering; beld italic: grand-mean centering) A
>> Level-1 << POPULAR = £. +
Level-2 = hotr
INTRCPT1 LEVEL 2 MODEL (bold italic: grand-mean centering)
EXTRAV Lo = fon + U
SEX 0 ‘00 0
POPULAR
Mixed| v
File Basic Settings Other Settings Run Analysis Help
Outcome LEVEL 1 MODEL (bold: group-mean centering; bold italic: grand-mean centering) A |
>> Level-1 << POPULAR |
Sheem o = -
Level-2 Fo*r
INTRCPT1 LEVEL 2 MODEL (bold italic: grand-mean centering)
EXTRAV £ = o+ U
SEX o~ el
POPULAR

This model has not been saved.

| Save as and Run|

Run the model shownl Cancel |

__Mixed|v|



Hox, Moerbeek, & Schoot, chapter 2: popularity data [ HLM7 MANUAL ]

The HTML file shows all kinds of output from the multi- Final estimation of fixed effects:

level analysis. To verify the numbers from the second ‘ _ Standard — Approx
. . Fixed Effect Coefficient t-ratio .~ p-value
column Table 2.1 (the first column does not split the e1ror af.
variance between levels and is thus not really part of a For I_‘\TRCPTLBﬁ
. ) INTRCPT2, 5 | 5.077859 0.086957| 58.395 99 =0.001
multilevel analysis) from Hox, Moerbeek, & van de
Schoot, scroll down to the end of the text file. The first Final estimation of variance components
thing you want to check is usually the Deviance. If this
seems OK, you can verify the parameter estimates. The Random Effect _tandard Vanance 7 2 p-value
fixed effects and variance components should be identi- Deviaton Component '
Xed efiects and variance components should be ide INTRCPTI, u, | 0.83334 0.69346 | 99 1227.26511 <0.001
cal to the ones from Table 2.1. This baseline model with- level-1, » 1.10535 122179
out any independent variables can be used to check the
intraclass correlation (ICC), and to check whether a mul-  Statistics for the current model
tilevel analysis is warranted. [Deviance = 6327467753
Number of estimated parameters =3
QUESTION 1: What is the ICC in this example?
WHLM: him2 MDM File: popularity.mdm Command File: whimtemp.hlm - ] X

We continue by adding predictor variables. To add the
level 1 predictors, first click on Level-1, then click the
variable you want to add, and select Add Variable
Uncentered. The book discusses the advantages of
entering variables centered, but in this simple example
we will stick to uncentered variables. Do this for EX-
TRAV and SEX. In the book predictors on both levels
are added at the same time. Here we will make the
extra step by first only adding the first level variables
and later also the second level variables.

File Basic Settings Other Settings

Outcome LEVEL 1 MODEL (bold: group-mean centering; bold italic: grand-mean centering) ~

POPULAR = £, +r

Run Analysis Help

Level-2
INTRCPT1 LEVEL 2 MODEL (bold italic: grand-mean centering)
EXTRAM
SEX Qutcome variable

POF I add variable uncentered I

add variable group centered

add variable grand centered

Delete variable from model

Mixed| v
The p|0t on the rlght shows how your model should WHLM: him2 MDM File: popularity.mdm Command File: whimtemp.hlm - m] X
) File Basic Settings Other Settings Run Analysis Help
look like and on the bottom we see the HTML output. Outcome A
LEVEL 1 MODEL (bold: group-mean centering; bold italic: grand-mean centering)
Because we now add two variables, but no interactions |->> t::z:; <1 POPULAR = £, + £,[EXTRAV) + £,(SEX) + 1
Yet: we are esﬁmaﬁng 5 parameters inStead Of 3. The INTRCPT1 LEVEL 2 MODEL (boid italic: grand-mean centering)
. . . EXTRAV _—
results of this output are not given in the book. SEX Fo = 1o * Yo
POPULAR £y = 1y
Fa2 = T2
Final estimation of fixed effects:
Fixed Effect Coefficient Siandesd t-ratio App TOX. p-value
error daf
For INTRCPT]1, 3,
INTRCPT2. 75 2.141383 0.116961 18309 99 =0.001
For EXTRAV slope, £,
INTRCPT2. 75, 0441513 0016150 27337 1898 | <0.001
For SEX slope, 8,
INTRCPT2, 7, 1.253137 0.037406 33.501 1898 | <0001 Mixed| v
afr ] z-value I I
Final estimation of variance components N
| POPULAR = o, + v, +EXTRAV + 1, +SEX + uy +r |
Standard Variance 3 ; N N
Random Effect Deviation Component . i p-value
INTRCPTL, 4, 0.78764 0.62037 99 2175.07480 <«0.001
level-1,»  0.76906 0.59146

Statistics for the current model

Deviance = 4933.952263
Number of estimated parameters = 5
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We now also (in addition to the WHLM: hlm2 MDM File: popularity.mdm  Command File: whimtemnp.hlm — — O *
level 1 variables that were both File Basic Settings Other Settings  Run Analysis  Help
significant) add a predictor variable & LEVEL 1 MODEL (bold: group-mean centering; bold italic: grand-mean centering) "
on the second level. Press Level-2, Lewvel-1
POPULAR = + P EXTRAV) + £ (SEX) +r
and make sure the By is selected | >> Lewvel-2 << Fot Fy S ]
from the Level 2 Model (the yel- | INTRCPTZ LEVEL 2 MODEL (bold italic: grand-mean centering)
. TEXP =&
low bar). Then click TEXP and se- £a fon T Ug
lect Add Variable Uncentered, just £y = 140
like you did in level 1. - .
’EE 20
Mixed| v
WHLM: hlm2 MDM File: popularity.mdm Command File: whimtemp.hlm — — O >

File Basic Settings Other Settings  Run Analysis  Help

M LEVEL 1 MODEL (bold: group-mean centering; bold talic: grand-mean centering) ~

—Levell | oopULAR = £ + £ (EXTRAV) + £.(SEX) +
> Level2 << = Fo Al )+ E5(SEX)
HIRCE LEVEL 2 MODEL (bold ttalic: grand-mean centering)
TEXP JE[] - Tag +|'."D?|TEKP + UO
Fy = Tio
Ey = igp
Mixed| ~
Final estimation of fixed effects:
We can see that both the level 1 and level 2 varia-
bles are significant. However, we have not added Fixed Effect Coefficient Standard -ratio Appro}(_ p-value
random slopes yet for any variables (as is done in rror af
table 2.1 in the book) For INTRCPTL. 5,
: ' INTRCPT2, 75 0.809326 0.168827 4.794 98  =0.001
TEXP. 3y 0088409 0.008676 10.190 98 =0.001
For EXTRAV slope. 5
Question 2: What is the explained vari- INTRCPT2,y;; 0454484 0016154 28134 1898 =0.001

For SEX slope, 5,

ance at level 1 and at level 2? -
INTRCPT2, ;;  1.254095 0.037265 33.653 1898 =0.001

Final estimation of variance components

Standard Variance , 5 ]
Random Effect Deviation Component af i p-value

INTRCPTL. u, 0.53736 028876 98 107211886 =0.001
level-1, » 0.76900 0.59136

Statistics for the current model

Deviance = 4862 295445
Number of estimated parameters = 6
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In the third column of Table 2.1, both
predictor variables from level 1 (sex and
extraversion) have random slopes. To
accomplish this in HLM, activate the
error terms for their slopes (B; and B,)
by clicking on u; and u,. This will make
them turn black instead of grey.

This completes model M1. Press Run
Analysis like you did before. Now you
might encounter a warning in the DOS
window about convergence. If this hap-
pens, type yes in the dos window, and
press Enter to continue fitting the mod-
el.

Once done, again open the output file
and inspect the parameter estimates like
you did before. You might notice that
they are slightly different from the ones
in Hox, Moerbeek, & Schoot. The reason
for this is that the error term for the
slope of the variable SEX is very small,
and therefore hard to estimate. In the
next model this slope will be removed.
This model corresponds to the third col-
umn of table 2.1 in Hox, Moerbeek, &
Schoot. We therefore conclude that
there is no slope variation of the SEX
variable between classes and therefore
the random slope estimation can be
dropped from the next analyses.

-

g-=0.55101
Standard error of 6 = 0.01877

T
INTRCPTLA; 131955 -0.18626 -0.02260
EXTRAVS, -0.18626 0.03411 -0.00083
SEX.5; -0.02260 -0.00083 0.00321

Standard errors of T

INTRCPTL.8;, 028836 0.04691 0.03269
EXTRAV,5, 0.04691 0.00838 0.00899
SEX.5; 0.03269 0.00899 0.01861

WHLM: him2 MDM File: pepularity.mdm  Command File: whimtemp.hlm  — O x
File Basic Settings  Other Settings  Run Analysis  Help

Outcome LEVEL 1 MODEL (bold: group-mean centering; bold italic: grand-mean centering)
Level-1
BNl POPULAR = g + F,(EXTRAV] + £,(SEX) + r
INTRCPT2 LEVEL 2 MODEL (bold italic: grand-mean centering)
TEXP £y = Top + o7 TEXP) + u,

Fy = Tap |4y

Ey = Tap HUz

Mixed| v

B CA\Program Files (x86)\HLM703Student\HLM2S.EXE - [m] X

Final estimation of fixed effects:

Fixed Effect Coefficient Sta_nda-_rd t-ratio Appm‘x_ p-value
error df
For INTRCPTL,
INTRCPT2, yq 0760605 0.195930 3.882 98 | =0.001
TEXP. yy 0.089399 0.008532 10478 98 | <0.001
For EXTRAV slope. §;
INTRCPT2. 75y  0.452810 0.024509 18.475 99 | <0.001
For SEX slope. 5;
INTRCPTL, 5, 1251146 0.037043 33773 99 1 =0.001
Final estimation of variance components
Fandom Effect ;;?T;lf’;i Cola;;i;;i d.f 7 p-value
INTECPTI. uy 1.14871 131955 86 20534339 =0.001

EXTRAV slope. u; 0.18468 0.03411 87 169.19730 =0.001
SEX slope. u; 1 0.05670 0.00321 87 8058867 =0.500 |
level-1, 0.74230 0.35101

Note: The chi-square statistics reported above are based on only 88 of 100
units that had sufficient data for computation. Fixed effects and variance
components are based on all the data.

Statistics for the current model

Deviance = 4811 353882
Number of estimated parameters = 11
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We continue by clicking on the error term for the parameter
of SEX to deselect it (turning from black to grey again), like in
the figure on the right.

The estimated variance components and the regression coeffi-
cients are now the same as table 2.2 and the 1st column
(Model M, ) of table 2.3 in the book.

To get the covariance between the class-level errors for the
intercept and extraversion slope we have to look at the off
diagonal elements of the variance-covariance output of HLM.

Question 3:

a. What is the intercept of the model?
b. What is the fixed effect of sex?

c. What is the effect of teacher experience?

d. What is the mean effect of extraversion?

e. What is the random effect of the slope of extra-
version?

WHLM: him2 MDM File: pepularity.mdm Command File: whimternp.hlm — — O X
File Basic Settings  Other Settings  Run Analysis  Help
Outcome LEVEL 1 MODEL (bold: group-mean centering; bold italic: grand-mean centering)
Level-1
> Level ? << POPULAR = £, + £,(EXTRAV) + £,(SEX) + r
INTRCPTZ2 LEVEL 2 MODEL (bold italic: grand-mean centering)
TEXP Fo = Top+ 70r TEXP] + 1
By = 13044
Fy = 1o
- Mixed| v

Final estimation of fixed effects:

Standard Approx.

Fixed Effect Coefficient t-ratio p-value
error df

For INTRCPTL. 5,
INTRCPT2. 5y 0738368 0.195209 3783 98 =0.001
TEXP, 7y 0.090813| 0.008598 10.563 98  <0.001

For EXTRAV slope, 4

INTRCPT2.y), 0432641 0.024478 18491 99  =0.001

For SEX slope. 8,
INTRCPT2, 7,y 1.252470) 0.036554 34263 1799 ==0.001

Final estimation of variance components
Random Effect If:?i?;i Cor\nméarr;li d.f. 7 p-value
INTRCPTL.u,  1.13200 128143 98 23864116 =0.001
EXTRAV slope. u;  0.18417 0.03392) 99 23761747 <0.001
level-1.»  0.74284 0.535181

Statistics for the current model

Deviance = 4812 806967
Number of estimated parameters = §

o =0.35181

Standard error of ¢ = 0.01837

T
INTRCPTI1 4, 1.28143 |0.18475
EXTRAV S, -0.18475  0.03392

Standard errors of ©

INTRCPTL.82;, 0.28119
EXTRAVE, 0.04653




Hox, Moerbeek, & Schoot, chapter 2: popularity data [ HLM7 MANUAL ]

In the next step to reproduce Model M, from Table 2.3, we
add the crosslevel interaction between Extraversion and
Teacher experience. This means we have to add TEXP as a
predictor for the coefficient of EXTRAV. To do thisin HLM
select below LEVEL 2 MODEL the line with the coefficient for
EXTRAV. This line should become yellow. Then click TEXP
from the variable list on the left, and click Add Variable Un-
centered. The model should then look like the figure on the
right. Run the Analysis and view the output. The Deviance
and model parameters are very similar to the ones from
model M, in table 2.3. You will find the coefficient for the
cross-level interaction at the table of fixed effects, below the
predictors for EXTRAV. It is somewhere between -0.02 and -
0.03, depending on the convergence and rounding settings
of the software.

Question 4: What is the explained slope variance

of extraversion by using teacher experience as

second level variable?

Question 5: What is the number of estimat-

ed parameters in this model?

—

WHLM: him2 MDM File: popularity.mdm  Command File: whimtemp.hlm — — m} *
File BasicSettings Other Settings  Run Analysis  Help
OLutco:T;e LEVEL 1 MODEL (bold: group-mean centering; bold italic: grand-mean centering)
EVEl-
3y Level Z << | POPULAR = £, + £,([EXTRAV) + £,(SEX) + r
INTRCPT2 LEVEL 2 MODEL (bold ttalic: grand-mean centering)
TEXP £y = Top * 1oy TEXP) + 1
£y = Typ 14 TEXP) + 0y
£z = iz
Mixed| v
Final estimation of fixed effects:
Fixed Effect Coefficient Standard t-ratio Apprc‘x_ p-value
error df
For INTRCPT1, 5,
INTRCPT2. y5p | -1.207112) 0.269006 -4.487 98  <0.001
TEXP. yy 0.226036] 0.016620 13.600 98 =0.001
For EXTRAV slope, |5,
INTRCPT2. yy 0.803142) 0.039564 20300 98  =0.001
TEXP. 3y -0.024699) 0.002520 -9.803 98  <0.001
For SEX slope. 3,
INTRCPT2, y4 1.240624) 0.036203 34.269 1799  =0.001
Final estimation of variance components
Standard Variance s 5 .
Random Effect Deviation Component af * p-value
INTRCPTL. uy 0.67405 045434 98 17283447 =0.001
EXTRAV slope, u; 0.06880 0.00473 98 12339265 0.042
level-1, » 0.74335 0.35256
Statistics for the current model
Deviance = 4747 624382
o =0.53256

Standard error of o* = 0.01835

T
INTRCPT1.8;  0.45434 |-0.02910
EXTRAVS, -0.02910  0.00473

Standard errors of T
INTRCPTL.8;, 0135903 0.02353
EXTRAV.S3, 0.02353 0.00399
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As eXp|a|ned in the book and Shown in the resu|t5 WHLM:hImEMDM File: popularity.mdm Command File: whimtemp.hlm ~— — m} X
’

File Basic Settings Other Settings  Run Analysis  Help

both the intercept and the slope of the coefficient

Create a new model using an existing MDM file d italic: grand-mean centering)
of extraversion on popularity is influenced by teach- LU O it ENE RLIES B r
i . Manually edit command(.hlm/.mlm)] file
er experience. A male student (SEX=0) with a extra- . }

version score of 0 in a class with a teacher with 0 Sxfs

Save model as .emf

years of experience has an expected popularity of

Save mixed model as .emf

—1.207 (these values are of course impossible, hence Make new MOM file ,
the importance of centering). A similar (male) stu- L s
. ) . . . Display MDM stats
dent will improve its popularity with .80 points for View Output
every point more extraversion. When teacher expe- Graph Equations i INcdcIoiphy
. . . . Graph Data » Level-1 equation graphing

riences increases, the intercept also increases Lovel recidual boe-whicker
Preferences

with .23 for every year of experience. So the same i Level-1 residual vs. predicted value

Level-2 EB/OLS coefficient confidence intervals

male student with no extraversion in a class with a T T T T T

teacher with 15 years of experience has an expected  Equation Graphing - Specification e
popularity score of —1.207+(15*.226)= 2.183. The » focus Z facus(1)
: Level1 |EHNEEN Level1 |0t chosen) - Choose up 1o B
teacher experience also lessens the effect of extra- oo
version on popularity. For a teacher with 15 years of Laahatf(not chasen) [ Levi2 IS hd 7000000
experience the regression coefficient of extraversion Level-3 = Level3 | | ] [13.000000
on popularity is only 0.803-(15*0.0247)=0.4325 Range of x-axis ReRER ol 3 l%
(compared to .803 in a class with a teacher with 0 [Entire range =~ |Choose upto B values v | ,W
years of experience).
In HLM we can visualize these effects. By cIicking Categoriestransforms/interactions Z focus(2) o e
1 | 2 | 3 | 4 | 5 | Lewvel-1 |[not chosen) - 003E Up o
File> Graph E ions>M | graphs . Then
e> Graph Equations odel graphs . Then put Lovet2 [t shoser -
Extraversion on the X-axis and select the Entire Range/Tiles/Color |
) Leveld = —
range as range of the x-axis. Use TEXP as a level-2 _
focus and select for the range of the “z”-axis 6 val kil | g e =l
- . . —
ues of your choice (we picked 2 to 26 years of teach- | E
X 0K | Cancel |
er experience).
{ ]
File Edit Graph Settings
5]
741 —— TEXP=2
—— TEXP=T
— TEXP=13
—— TEXF=18
e
o
<
- |
E 4.02
o
o
Question 6: visualize the findings we ool
wound earlier, that there is interecept var-
iance of SEX but no slope variance. .
0o 25s 5 778 10.00
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STEP 5: Answers to question:

Question 1: 0.69/(1.22+0.69)=.36

Question 2:
° R2 at level 1: (1.222-0.591)/1.222= .52

. R2 at level 2: (0.694-0.289)/0.694= .58

Question 3:

a. The intercept is 0.738
b. The fixed effect of sex is 1.252

c. The effect of teacher experience is 0.091
d. The mean effect of extraversion is 0.453
e. The random effect of the slope of extraversion is 0.034

Question 4: (0.03392-0.00473)/0.03392= .86

Question 5: 9

Question 6: Two possibilities:

B Graph for model in - a x B Graph for model in - O S
File Edit Graph Settings File Edit Graph Settings
1 @™
7T R 2,02 : 5
- H TEXF =23EX=10
—— SEX=1 é f =1
== ? = —_— =0
et —- -
— — - s =
g.a4 anmd— — — - L =0
02 I - L — - TEXP=13.5EX=1
{ - - —— TEXP=18SEX=0
14 — - TEXP=18.5EX=1
< 1 4 - L J— =0
_ < |- s
=1 12 = -~ e -
o =L R o
o o |- o -
o o P ~
o
P /
2.804 00 -
2 s
248 T T T /
1.00 3.25 5.50 7.75 10.00 00042 Py Py T 00
EXTRAV - EXhTFh AV o ’




